# TABLE OF CONTENTS

## INTRODUCTION

| Security concerns | 4 |

## TESTING CENTER CAPABILITIES

### Generating Your Tests

- Instructor-generated tests .................................................. 5
- LXR-generated tests.......................................................... 5
  - The appearance of an LXR-generated test ................................ 6
  - The appearance of an LXR-generated test key .................................. 8
  - Advantages of using LXR-generated tests ...................................... 9

### Scoring Your Tests

- Scoring instructor-generated tests ........................................... 10
- Scoring LXR-generated tests .................................................. 10
  - The Scantron ........................................................................ 12

### Analyzing Your Tests

- Alphabetical class roster ....................................................... 14
- Roster for posting ..................................................................... 16
- Roster showing raw scores ..................................................... 17
- Test Statistics by question ..................................................... 18
- Test Statistics for a test ....................................................... 20
  - Individual (student) Scores Report ........................................... 22
  - Histogram of adjusted scores for a specific test .......................... 24
  - Histogram of course grade ..................................................... 26

### Rescoring Your Tests

- Discovering an incorrect key ................................................... 27
  - Having questions successfully challenged/Deciding that a question is not good .................................................. 28
- Crediting all students for a question ........................................... 28
- Accepting more than one answer as correct .................................. 28
- Weighing the question differently ............................................. 28
- Throwing out the question ........................................................ 28
- Needing to raise an entire class’s scores ..................................... 29

### Keeping Your Gradebook

- Manipulating scores ............................................................... 29
- Reporting options ..................................................................... 30
INTRODUCTION

Welcome to Nova Southeastern University Health Professions Division’s Testing Center. This guide is designed to answer three basic questions: “What can the Testing Center do for me,” “What should I do to help the Testing Center help me,” and “How can I create better tests?”

The Testing Center is located in the Office of Academic Support/Testing Center, room 1522 on the fifth floor of the HPD Administration Building (the Terry Building). Hours of operation are Monday through Friday, 8:00 a.m. to 5:00 p.m.

Testing Center Staff
Stanley Cohen, Ed.D. – Vice Dean, H.P.D.
   extension 21523, e-mail scohen@nsu.nova.edu

Patrick C. Hardigan, Ph.D. – Executive Director of Assessment, Evaluation and Faculty Development
   extension 21524, e-mail patrick@nsu.nova.edu

TESTING CENTER EMAIL
hpdtc@nova.edu or hpdtc@nsu.nova.edu

Beverly Kaner – Office Manager, H.P.D. Testing Center
   Extension 21522, e-mail bkaner@nsu.nova.edu

Jacquelyn Moore – Coordinator, H.P.D. Testing Center
   extension 21733, e-mail jmoore@nova.edu

Rosario Ortiz – Assistant Coordinator, H.P.D. Testing Center
   extension 21525, orosario@nova.edu

We invite you to invest a few minutes to read this manual and use it as a reference tool. We believe this guide will help you utilize the Testing Center to its fullest extent, which will make all aspects of student testing operate as efficiently as possible.

SECURITY CONCERNS
The Testing Center takes strict precautions to avoid security problems. You can be assured your questions, answers, and student grades are confidential. Students are not allowed in the Testing Center. The Testing Center, as well as the general office area, is locked at night. All materials (when not under direct supervision) are kept in a safe room to which only Testing Center personnel have the key. Our computer system is not networked with any other and is not Internet accessible, therefore it cannot be “hacked” into. (The e-mail addresses seen above are for a different computer system.) Papers with confidential information, (such as student grades or answer keys), which need to be thrown away are kept in a locked bin until they are shredded by a bonded shredding service.
WHAT CAN THE TESTING CENTER DO FOR ME?

TESTING CENTER CAPABILITIES

The Testing Center performs five major functions for Nova Southeastern University faculty. We generate tests, score tests, provide full test analyses, rescore tests, and compute and record students’ grades.

GENERATING YOUR TESTS

The first function the Testing Center performs is generating your tests. This can be accomplished either by making photocopies of an original provided by you (an instructor-generated test) or by creating a test using our test generating software, LXR.

The instructor will be called when his/her tests are ready to be picked up. For security reasons, the Testing Center recommends leaving tests locked up with us until near the time of the exam. On exam day, the instructor will pick up the complete testing packet which includes the test originals (plus answer keys and earlier proofs of the exam if the test was created by LXR), the desired number of copies, and sufficient Scantron sheets (preprinted bubble sheets that can be read by a scanner) for the class.

Instructor-Generated Tests

Some professors prefer to generate their own tests. For those who do, the Testing Center will make the required number of copies of up to four different versions. If the questions are multiple-choice, true/false, or limited (up to five) matching, the tests can be scored using Scantron response sheets and the Testing Center’s scanners. The maximum number of questions allowed on a single exam is 200.

The Testing Center can copy tests on different colored paper, with or without cover sheets, and with or without different colored paper for cover sheets.

LXR-Generated Tests

LXR software stores questions, answers, instructions, and black and white illustrations in files called item banks which can be added to, edited, and re-used endlessly. Once material has been added to an item bank, it can be selected to form a test. LXR formats multiple choice, true/false, and limited (up to five) matching types of questions. The maximum number of questions allowed on a single exam is 200.

The appearance of an LXR-generated test

Figure 1 on the next page is an example of an LXR-generated test.
INSTRUCTIONS FOR COMPLETING YOUR SCANTRON

♦ You must use a #2 pencil only.
♦ Please print your name, class and course instructor on your scantron.
♦ You must fill in the bubbles on your scantron, starting at far left, that correspond to your

NSU ID NUMBER.

OMIT THE "N" AND START WITH THE "0".

3 EXAMPLES: Your number is N00112233; you bubble 00112233.
Your number is N00011223; you bubble 00011223.

DO NOT USE YOUR SOCIAL SECURITY NUMBER.
DO NOT ADD OR SUBTRACT "0's" FROM YOUR NSU ID NUMBER.

♦ You must fill in the bubbles on your scantron that correspond to your name, Last name, First name.
♦ You must fill in the bubble on your scantron that corresponds to your test form, A, B, C, or D.
♦ You must erase completely where necessary.
♦ SELECT THE BEST ANSWER.

1. T F Concerning the anterior compartment of the arm, innervation is from a nerve that arises from the lateral cord of the brachial plexus.

2. Each of the following muscles (of the lower extremity) is supplied primarily by the artery listed with it, EXCEPT for:
   A. Flexor digitorum longus - anterior tibial artery.
   B. Adductor brevis - deep femoral artery.
   C. Extensor digitorum brevis - dorsalis pedis artery.
   D. Vastus lateralis - femoral artery.
   E. Biceps femoris - perforating branches of the deep femoral artery.

3. A polio patient has had destruction of the anterior horn cells (motor cells) in the spinal cord at levels L2 - L3. Which of the following actions would be affected (i.e. which of the actions would be significantly weaker)?
   A. Extension at the knee joint
   B. Flexion of the thigh
   C. Extension of the leg
   D. Adduction at the hip joint
   E. All actions (A - D) would be affected significantly
1-1. Exam name. Examples would be Exam 1, Midterm, Final, Quiz 3, etc.
1-2. Student name and Course number. Many instructors find it helpful to have their students indicate which test they took as it can aid in resolving disputes such as which version of a test was taken, accusations of missing or unreadable pages, or accusations of mispagination.
1-3. Instructions to the students. The instructions shown here are the standard ones used by the Testing Center. If you would prefer to use alternate instructions, please let the Testing Center know and we will be happy to use them.
1-4. Questions. Notice the different formats between questions number 1 and 2. Question 1 shows the standard formatting for true/false questions and Question 2 shows the standard formatting for multiple-choice questions. The maximum number of choices on a multiple-choice question is five, but it is not necessary to use all five. Some professors choose to use three or four. It is possible to alternate between number of responses from question to question.
1-5. Date the exam was printed or if you prefer, we can now change that to actual date test is being given or delete this information altogether.
1-6. Version. (We can scramble answers to questions, up to 4 versions, A, B, C or D.)
1-7. Page number.

The appearance of an LXR-generated test key
Figure 2 on the next page is an example of an LXR-generated test key.
# ANSWER KEY REPORT

1 for EXAM 2

<table>
<thead>
<tr>
<th>#</th>
<th>ID</th>
<th>Points</th>
<th>Type</th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>UNTITLED-B 1</td>
<td>1.00</td>
<td>MCS</td>
<td>A</td>
<td>C</td>
<td>D</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>UNTITLED-B 2</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>D</td>
<td>C</td>
<td>A</td>
</tr>
<tr>
<td>3</td>
<td>UNTITLED-B 3</td>
<td>1.00</td>
<td>MCS</td>
<td>B</td>
<td>E</td>
<td>D</td>
<td>A</td>
</tr>
<tr>
<td>4</td>
<td>UNTITLED-B 4</td>
<td>1.00</td>
<td>MCS</td>
<td>B</td>
<td>D</td>
<td>D</td>
<td>A</td>
</tr>
<tr>
<td>5</td>
<td>UNTITLED-B 5</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>A</td>
<td>D</td>
<td>C</td>
</tr>
<tr>
<td>6</td>
<td>UNTITLED-B 6</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>7</td>
<td>UNTITLED-B 7</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>C</td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>8</td>
<td>UNTITLED-B 8</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>E</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>9</td>
<td>UNTITLED-B 9</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>A</td>
<td>B</td>
<td>C</td>
</tr>
<tr>
<td>10</td>
<td>UNTITLED-B 10</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>E</td>
<td>B</td>
<td>E</td>
</tr>
<tr>
<td>11</td>
<td>UNTITLED-B 11</td>
<td>1.00</td>
<td>MCS</td>
<td>D</td>
<td>E</td>
<td>B</td>
<td>C</td>
</tr>
<tr>
<td>12</td>
<td>UNTITLED-B 12</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>13</td>
<td>UNTITLED-B 13</td>
<td>1.00</td>
<td>MCS</td>
<td>B</td>
<td>A</td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>14</td>
<td>UNTITLED-B 14</td>
<td>1.00</td>
<td>MCS</td>
<td>D</td>
<td>A</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>15</td>
<td>UNTITLED-B 15</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>16</td>
<td>UNTITLED-B 16</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>B</td>
<td>B</td>
<td>A</td>
</tr>
<tr>
<td>17</td>
<td>UNTITLED-B 17</td>
<td>1.00</td>
<td>MCS</td>
<td>B</td>
<td>B</td>
<td>E</td>
<td>B</td>
</tr>
<tr>
<td>18</td>
<td>UNTITLED-B 18</td>
<td>1.00</td>
<td>MCS</td>
<td>A</td>
<td>A</td>
<td>C</td>
<td>A</td>
</tr>
<tr>
<td>19</td>
<td>UNTITLED-B 19</td>
<td>1.00</td>
<td>MCS</td>
<td>A</td>
<td>E</td>
<td>C</td>
<td>D</td>
</tr>
<tr>
<td>20</td>
<td>UNTITLED-B 20</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>C</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>21</td>
<td>UNTITLED-B 21</td>
<td>1.00</td>
<td>MCS</td>
<td>A</td>
<td>A</td>
<td>B</td>
<td>C</td>
</tr>
<tr>
<td>22</td>
<td>UNTITLED-B 22</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>A</td>
<td>E</td>
<td>A</td>
</tr>
<tr>
<td>23</td>
<td>UNTITLED-B 23</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>E</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>24</td>
<td>UNTITLED-B 24</td>
<td>1.00</td>
<td>MCS</td>
<td>B</td>
<td>D</td>
<td>D</td>
<td>C</td>
</tr>
<tr>
<td>25</td>
<td>UNTITLED-B 25</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>D</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>26</td>
<td>UNTITLED-B 26</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>A</td>
<td>D</td>
<td>A</td>
</tr>
<tr>
<td>27</td>
<td>UNTITLED-B 27</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>C</td>
<td>A</td>
<td>E</td>
</tr>
<tr>
<td>28</td>
<td>UNTITLED-B 28</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>B</td>
<td>A</td>
<td>C</td>
</tr>
<tr>
<td>29</td>
<td>UNTITLED-B 29</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>D</td>
</tr>
<tr>
<td>30</td>
<td>UNTITLED-B 30</td>
<td>1.00</td>
<td>MCS</td>
<td>D</td>
<td>A</td>
<td>C</td>
<td>D</td>
</tr>
<tr>
<td>31</td>
<td>UNTITLED-B 31</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>32</td>
<td>UNTITLED-B 32</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>33</td>
<td>UNTITLED-B 33</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>B</td>
<td>A</td>
<td>D</td>
</tr>
<tr>
<td>34</td>
<td>UNTITLED-B 34</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>C</td>
</tr>
<tr>
<td>35</td>
<td>UNTITLED-B 35</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>36</td>
<td>UNTITLED-B 36</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>37</td>
<td>UNTITLED-B 37</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>38</td>
<td>UNTITLED-B 38</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>39</td>
<td>UNTITLED-B 39</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>40</td>
<td>UNTITLED-B 40</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>B</td>
<td>C</td>
<td>B</td>
</tr>
<tr>
<td>41</td>
<td>UNTITLED-B 41</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>42</td>
<td>UNTITLED-B 42</td>
<td>1.00</td>
<td>MCS</td>
<td>A</td>
<td>D</td>
<td>D</td>
<td>B</td>
</tr>
<tr>
<td>43</td>
<td>UNTITLED-B 43</td>
<td>1.00</td>
<td>MCS</td>
<td>B</td>
<td>E</td>
<td>E</td>
<td>B</td>
</tr>
<tr>
<td>44</td>
<td>UNTITLED-B 44</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>45</td>
<td>UNTITLED-B 45</td>
<td>1.00</td>
<td>T/F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>46</td>
<td>UNTITLED-B 46</td>
<td>1.00</td>
<td>MCS</td>
<td>A</td>
<td>C</td>
<td>A</td>
<td>E</td>
</tr>
</tbody>
</table>
2-1. Name of exam.
2-2. Question number. This is the number of the question on the test. Notice that the first item (an instruction) is not numbered.
2-3. Question ID. The question ID is composed of two parts, an objective (in this example, Header, Untitled-C, or Untitled-G) and the sequence number. If an instructor wished to discuss, edit, or reuse a specific question, he/she would need to identify it by both parts.
2-4. Points. The number of points the question is worth.
2-5. Type. Different types are T/F (true/false), INS (instructions), MCS (multiple choice, single response) or MCM (multiple choice, multiple responses).
2-6. Answers. The top numbers (0-3) indicate a version of a test. 0 is Version A, 1 is Version B, 2 is Version C, 3 is Version D. The lower letters indicate the correct response for each question and each version. Notice that on question 1 only one answer, T, is used as True is the correct response for all versions. If one wished to find the answer for question 4, version C, one would find question 4 in the far left column, then intersect it with the letters under answer area number 2 to find that the correct answer is D.
2-7. The date and time the report was printed.
2-8. Page number.

Advantages of using LXR-generated tests

There are five advantages to using LXR to generate your tests. First, having your questions stored in an item bank can make creating a test practically painless. Instead of having to create new questions for every test, you can draw from questions that have proven to be good indicators of learned material. If you choose to provide key word tags for your item bank questions, tests can be generated as easily as commanding LXR to create, for example, “a 25-question test using keyword ‘infection’“. Second, storing questions in an item bank allows you to refine your questions as you are able to edit confusing wording for clarity. Third, in order to discourage cheating, up to four different versions of your test can be created. The different versions contain the same questions in the same order, but the order of responses is changed with each version. LXR provides complete control over the scrambling process. Responses can be scrambled or not, or any portion of the responses can be scrambled (only A & B, A through C, A through D, or A through E). Fourth, when a test has been created through LXR, you don’t need to create a key for scoring because LXR has stored information on the correct answers. This eliminates many of the opportunities for error that can occur when creating keys manually. Fifth, LXR combines each version’s question statistics into a single report. Although LXR can score and analyze tests that it did not create, those “outside” tests have to be scored separately for each version. The resulting analysis is for a single version only, which can make trying to see how the class as a whole did on any given question more difficult.
SCORING YOUR TESTS

The Testing Center can score instructor-generated tests, LXR-generated tests, or can assist in scoring tests in off-campus locations. Turn-around time is usually a few hours, except during midterms and finals. Tests are scored on a “first-come, first-served” basis.

Scoring an instructor-generated test
The Testing Center can score up to 200 multiple-choice, true/false, or limited matching questions in up to four versions provided that students have recorded their responses on a Scantron sheet. If the instructor wishes to include other types of questions (short answer, fill in the blank, or essay) on the test, he/she will have to grade those manually, but the scores can be combined with the scores from the scanner-graded portion of the test. The instructor will need to provide a key for each version of the test to be scored and will need to separate the students’ tests by which version they took.

Most instructors prefer to have all questions worth the same number of points. LXR scoring creates a raw score which can then be manipulated to have the test worth the desired number of points. For example, if a test were composed of 55 questions each worth the same number of points, and the instructor wanted the test worth 100 points, LXR would score the test based on the number correct out of 55. Then, the raw scores would be imported into a gradebook program, and the raw scores would be multiplied by 1.81818 to have the scores based on 100 points.

If an instructor prefers to weigh some questions more heavily than others, LXR can assign questions point values in 1/100 increments.

Scoring an LXR-generated test
Scoring an LXR-generated test is very easy. Keys are not required and students’ Scantrons do not have to be separated by version. Generally, the LXR scoring program recognizes one correct answer for each question. However, LXR can create questions which require multiple responses and then give partial credit for incomplete responses if all of the required answers were not given. For example, if the question and responses were:

Mark all of the following which are possible causes of headaches.
A. High blood pressure
B. Brain tumor
C. Stress
D. Eye strain

and the instructor wanted students to mark all of the answers, students would receive one point (or whatever the assigned point value is) for each answer marked, up to four points. Multiple response questions have two areas for special consideration. First, using this feature could result in those questions being worth more than single-response questions on the test. Second, the instructor must decide how to handle guessing. If students know
that they will receive partial credit for each correct answer and not be penalized for marking incorrect answers, then an intelligent student would adopt the strategy of marking all answers. To combat that strategy, LXR can give negative points for an incorrect response and positive points for the correct response. However, in the interests of fairness, students should be forewarned that they will be penalized for marking answers which are not correct (guessing). The students should be warned because this type of scoring is very different from that customarily used by the Testing Center. Ordinarily, the program awards positive points for a correct answer and zero points for an incorrect answer.

Most instructors prefer to have all questions worth the same number of points. LXR scoring creates a raw score which can then be manipulated to have the test worth the desired number of points. For example, if a test were composed of 55 questions each worth the same number of points and the instructor wanted the test worth 100 points, LXR would score the test based on the number correct out of 55. Then, the raw scores would be imported into a gradebook program, and the raw scores would be multiplied by 1.81818 to have the score based on 100 points.

If an instructor prefers to weigh some questions more heavily than others, LXR can assign questions point values in 1/100 increments.
The Scantron

Figure 3 below is an example of a student scantron.

3-1. I.D. Number. This area is for the students’ NSU number. It is imperative that students fill in this area and fill it in correctly. Notice that the last column on the right is blank.

3-2. Phone Number. There is no need to have students fill in this information.

3-3. Name. This area is for the student’s name: Last name space first name.
3-4. Code. The Colleges of Pharmacy and Nursing students must fill in this information. The College of Pharmacy uses this area to indicate in which learning center the student belongs (FL for Ft. Lauderdale, PB for Palm Beach, PR for Puerto Rico, and IN for International). Likewise, the College of Nursing also uses this area to indicate in which learning center the student belongs (FL for Ft. Lauderdale, BP for Kendall Baptist, NB for Kendall non-Baptist and FM for Ft. Myers). This feature may also be used by instructors who teach different groups of students in the same class (for example a class composed of first year dental students and first year medical students) and would like to distinguish between them. If used, please alert the Testing Center staff so they may modify the report format to include this information.

3-5. Test Form. This area is where the student indicates which test form he/she took (A, B, C, D). If only one form is used, it is not necessary to complete this. If more than one form is used, it is very important that the student correctly bubble in which test form he/she is taking. Failure to do so will result in an extremely low grade (somewhere between 7 and 16 on a 100 point test). The grade can be corrected, but doing so wastes time unnecessarily and causes needless confusion.

3-6. Exam Number. There is no need to have students fill in this information.

3-7. Name, Class, Date. This area is for the students’ name, class, and date. It is not scanned and is not crucial to the Testing Center, but instructors find the information very helpful in maintaining their own files.

3-8. Answer portion. This is the area in which students record their responses for each question. Notice the T F markings at the tops of each column. They are to remind students that a true response on a true/false question should be recorded in column A and a false response on a true/false question should be recorded in column B.

With the exception of the College of Osteopathic Medicine, students’ scantrons will be returned with the rest of the analysis packet after an exam has been scored. We will retain the College of Osteopathic Medicine’s students’ scantrons in our “safe” room for one year.

ANALYZING YOUR TESTS

The Testing Center provides test analyses of scoring done on either instructor-generated or LXR-generated tests. The analyses include statistics on the class as a whole, on each test, and on each question. Question and test analyses for instructor-generated tests are printed separately by the different versions taken. For LXR-generated tests, those analyses are printed as if all students took version A.

An easy reference guide of the material in this section is available from the Testing Center. Please ask either Beverly Kaner or Jacquelyn Moore for a copy of “Item Analysis Short Form”.

The packet an instructor receives after his/her test has been scored is composed of the following parts: 1.)An alphabetical class roster with scores; 2.)A roster for posting; 3.)A roster showing raw scores; 4.)Test statistics by question; 5.)Test statistics for the test; 6.)Student Scantrons; 7.)Individual student response sheets (only upon request); 8.)Histogram of adjusted scores for a specific test (only upon request); 9.)Histogram of course grade (only upon request). The following is a detailed description of each part:
Figure 4 below is an example of an alphabetical class roster.
4-1. Course number.
4-2. Date the report was printed.
4-3. Instructor’s name.
4-4. Key to the score columns. For example, if you wanted to check Jane College’s score on Exam 2, you would first check the key to learn that Exam 2 scores are in column 3. Then you would see that her score was 88.
4-5. Number for each student. This is an optional feature.
4-6. Students’ names listed alphabetically.
4-7. Students’ Social Security numbers.
4-8. Scores for each assignment.
4-9. A cumulative grade for the course.
4-10. Class Average. The average of all the students’ scores in that column.
4-11. Maximum. The highest grade in that column.
4-12. Minimum. The lowest grade in that column.
4-13. Median. The point at which half the students’ grades for that column are higher and half lower.
4-14. Standard Deviation. The standard deviation gives information on the range of scores. 99% of all the scores fall within 3 standard deviations, it is a measure of dispersion about the mean. The smaller the standard deviation, the more students’ scores are about the same.
4-15. Adjusted Points. The highest number of points possible in that column.

This is a standard alphabetical report. The program supports many formatting options such as: selecting only certain students to print, arranging students by course grade (the program will not rank by a single exam, only by the course grade), landscape printing, providing cumulative scores for sub-categories (such as quizzes, exams, practicals, etc.), selecting only certain assignments to print, and choosing whether or not to print a cumulative grade. These options are not ordinarily used in a standard printout, but are available upon request.
2.) Roster for posting
Figure 5 below is an example of a roster for posting.

<table>
<thead>
<tr>
<th># Assignment</th>
<th>1</th>
<th>EXAM 1</th>
<th>3</th>
<th>EXAM 2</th>
<th>5</th>
<th>EXAM 3</th>
<th>6</th>
<th>PRACTICAL 1</th>
<th>4</th>
<th>PRACTICAL 2</th>
<th>7</th>
<th>PRACTICAL 3</th>
</tr>
</thead>
</table>

**ASSIGNED ID**

<table>
<thead>
<tr>
<th>ID</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>0101</td>
<td>88.0</td>
<td>91.0</td>
<td>88.0</td>
<td>93.0</td>
<td>92.0</td>
<td>92.0</td>
<td>90.7%</td>
</tr>
<tr>
<td>A8T5G9K3</td>
<td>88.0</td>
<td>92.0</td>
<td>90.0</td>
<td>95.0</td>
<td>92.0</td>
<td>89.0</td>
<td>91.0%</td>
</tr>
<tr>
<td>B8T4</td>
<td>90.0</td>
<td>89.0</td>
<td>100.0</td>
<td>93.0</td>
<td>92.0</td>
<td>91.0</td>
<td>92.5%</td>
</tr>
<tr>
<td>X427Y2</td>
<td>94.0</td>
<td>93.0</td>
<td>94.0</td>
<td>91.0</td>
<td>96.0</td>
<td>89.0</td>
<td>92.8%</td>
</tr>
<tr>
<td>Class Average</td>
<td>90.0</td>
<td>91.3</td>
<td>93.0</td>
<td>93.0</td>
<td>93.0</td>
<td>90.3</td>
<td>91.8%</td>
</tr>
<tr>
<td>Maximum</td>
<td>94.0</td>
<td>93.0</td>
<td>100.0</td>
<td>95.0</td>
<td>96.0</td>
<td>92.0</td>
<td>92.8%</td>
</tr>
<tr>
<td>Minimum</td>
<td>88.0</td>
<td>89.0</td>
<td>88.0</td>
<td>91.0</td>
<td>92.0</td>
<td>89.0</td>
<td>90.7%</td>
</tr>
<tr>
<td>Median</td>
<td>89.0</td>
<td>91.5</td>
<td>92.0</td>
<td>93.0</td>
<td>92.0</td>
<td>90.0</td>
<td>91.8%</td>
</tr>
</tbody>
</table>

**Scores**

<table>
<thead>
<tr>
<th>Score</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
<td></td>
</tr>
</tbody>
</table>

5-1. Course number.
5-2. Date the report was printed.
5-3. Instructor’s name.
5-4. Key to the score columns. For example, if student 0101 wanted to check his/her score on Exam 2, he/she would first check the key to learn that Exam 2 scores are in column 3. Then he/she would see that his/her score is 88.
5-5. Assigned ID number. Different colleges within HPD use various formats for assigned ID number. Some colleges use the last four digits of a student’s Social Security number (as shown by the first student in this report). Other colleges use a randomly generated combination of letters and numbers either four, six or eight digits long. Still other colleges let their students pick their own posting ID. Within a given college, the format for all students’ assigned IDs is the same.
5-6. Scores for each assignment.
5-7. A cumulative grade for the course.
5-8. Class Average. The average of all the students’ scores in that column.
5-9. Maximum. The highest grade in that column.
5-10. Minimum. The lowest grade in that column.
5-11. Median. The point at which half the students’ grades for that column are higher and half are lower.
5-12. Standard Deviation. The standard deviation gives information on the range of scores. 99% of all the scores fall within 3 standard deviations, it is a measure of dispersion about the mean. The smaller the standard deviation, the more students’ scores are about the same.
5-13. Adjusted Points. The highest possible number of points for that column.
If you find that you were not given a roster for posting or that you lost it, **DO NOT POST THE ALPHABETICAL ROSTER!** Doing so will violate your students’ right to privacy. Call the Testing Center and ask for a posting roster.

3.) **Roster showing raw scores**
Figure 6 below is an example of a roster showing raw scores

| Name of the exam. | Course number and exam name (Quiz 1, Exam 2, Final, etc.) | Instructor and number of Scantron sheets scored. | ID. The students’ Social Security numbers. These are not always accurate, as the student may mis-bubble the ID section. | Student name. Students’ names as recorded on their Scantron sheets. These may contain misspellings, extra spaces, or question marks as they are listed just as the scanner read them and students frequently make mistakes in this area. | V. The version of the test taken by the student. 0 = A, 1 = B, 2 = C, 3 = D. | Points. The number correct multiplied by the point value for each question. This number will be exported into the Gradebook program. | %. The raw score converted into a percentage. | Date and time the report was generated. | Page number. |
4.) Test statistics by question
Figure 7 below is an example of an analysis of each question.

<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Admins</th>
<th>Pts</th>
<th>Avg</th>
<th>Item Statistics Report for Exam 2</th>
<th>Figure 7</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Overall Omits A(True) B(True) C  D  E</td>
<td></td>
</tr>
<tr>
<td>5:1</td>
<td>6:1</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>2</td>
<td>72.11</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.05</td>
<td>0.02</td>
<td>0.02</td>
<td>0.02</td>
<td>+0.259</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.063</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.095</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.095</td>
</tr>
<tr>
<td>1.2</td>
<td>86</td>
<td>0</td>
<td>41</td>
<td>21</td>
<td>13</td>
<td>5</td>
</tr>
<tr>
<td>MCS</td>
<td>0.48</td>
<td>0.00</td>
<td>0.48</td>
<td>0.24</td>
<td>0.15</td>
<td>+0.144</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.414</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.195</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.095</td>
</tr>
<tr>
<td>1.3</td>
<td>86</td>
<td>1</td>
<td>3</td>
<td>10</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td>MCS</td>
<td>0.71</td>
<td>0.01</td>
<td>0.03</td>
<td>0.12</td>
<td>0.02</td>
<td>+0.164</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.111</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.067</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.178</td>
</tr>
<tr>
<td>1.4</td>
<td>86</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>79</td>
<td>1</td>
</tr>
<tr>
<td>MCS</td>
<td>0.92</td>
<td>0.01</td>
<td>0.01</td>
<td>0.02</td>
<td>0.02</td>
<td>+0.225</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.111</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.318</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.088</td>
</tr>
<tr>
<td>1.5</td>
<td>86</td>
<td>0</td>
<td>1</td>
<td>7</td>
<td>2</td>
<td>67</td>
</tr>
<tr>
<td>MCS</td>
<td>0.78</td>
<td>0.00</td>
<td>0.01</td>
<td>0.08</td>
<td>0.02</td>
<td>+0.454</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.111</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.245</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-0.088</td>
</tr>
<tr>
<td>1.6</td>
<td>86</td>
<td>0</td>
<td>4</td>
<td>57</td>
<td>9</td>
<td>13</td>
</tr>
<tr>
<td>MCS</td>
<td>0.66</td>
<td>0.00</td>
<td>0.05</td>
<td>0.66</td>
<td>0.10</td>
<td>+0.350</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.350</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.168</td>
</tr>
<tr>
<td>1.7</td>
<td>86</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>73</td>
<td>2</td>
</tr>
<tr>
<td>MCS</td>
<td>0.85</td>
<td>0.00</td>
<td>0.00</td>
<td>0.01</td>
<td>0.01</td>
<td>+0.85</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.211</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>+0.118</td>
</tr>
</tbody>
</table>
19

7-1. Exam name (Quiz 1, Exam 2, Final, etc.)
7-2. Course number and exam name.
7-3. Instructor’s name and number of Scantrons read.
7-4. Key to the report.
7-5. Item. The section number and question number. All Testing Center tests only have one section.
7-6. Admins. The number of Scantron sheets read.
7-7. Omits. The number of students who didn’t answer that question.
7-8. A (True) B (False) C D E. The number of students who answered for each letter. For example, on question 1, 6 students answered E. The correct answer is **bolded**.
7-9. Type. The question type. MCS = Multiple Choice, Single Response, MCM = Multiple Choice, Multiple Response, TF = True/False.
7-10. p. Index of question difficulty. *P* values range from 0 to 1.00, with higher *p* values indicating that more students answered the question correctly. The higher the *p* value, the easier the question.
7-11. Pts. The point value of the question.
7-12. Avg. The average test score (in percent) of the students for each answer. For example, on question 1, the 4 students who answered A averaged a 66 on the exam. However, the 72 students who answered D (the correct answer) averaged a 72.11 on the exam.
7-13. rpb. The point biserial is an index of how well a question discriminates between students who performed well on the test overall and those who did not. On the correct response, a **positive** point biserial indicates that the question is answered correctly more often by those who scored well on the overall exam, a **negative** point biserial indicates that the question is answered correctly more often by those who scored poorly on the overall exam, a **neutral** point biserial indicates a nondiscriminating question. Point biserials of .30 and above are good discriminators. On the incorrect responses, negative point biserials indicate good discrimination, with lower negative numbers indicating better discrimination, (e.g. -.419 is a better discriminator than -.124).
7-14. The time and date the report was generated.
7-15. Page number.
5.) Test statistics for a test
Figure 8 below is an example of an analysis of a test.
8-1. Exam name. (Quiz 1, Exam 2, Final, etc.)
8-2. The range of raw scores from lowest to highest divided into equal increments.
8-3. The number of students who scored within a given range. For example, this particular analysis indicates that 19 students scored between 36 and 40.
8-4. Test Name. The file name of the exam.
8-5. Test Date. The date the exam was created.
8-6. Number of Examinees. The number of Scantron sheets scored.
8-7. Number of Items. The number of questions.
8-8. Maximum Point Value. The highest raw score possible.
8-9. Highest Score. The highest raw score made by a student. (Expressed both as a raw score and a percentage.)
8-10. Lowest Score. The lowest raw score made by a student. (Expressed both as a raw score and a percentage.)
8-11. Median. The point value at which half the students scored higher and half the students scored lower. (Expressed both as a raw score and a percentage.)
8-12. Mean. The average of all the students’ scores. (Expressed both as a raw score and a percentage.)
8-13. Standard Deviation. The standard deviation gives information on the range of scores. 99% of all the scores fall within 3 standard deviations, it is a measure of dispersion about the mean. The smaller the standard deviation, the more students’ scores are about the same.
8-14. Test Reliability. The reliability index given by the Testing Center is known as internal consistency. It focuses on how related the test questions are. Reliability estimates range from 0 to 1.0, with estimates closer to 1.0 indicating a “superior” test.
8-15. Standard Error of Measurement. The standard error of measurement is a reflection of the variability of an individual’s score if the test were administered repeatedly to the same person. Using properties of the normal curve, one can make some assertions about the accuracy of an individual’s test score. For example, suppose an examinee scored 37 correct on a test and possessed a calculated standard error of measurement ±2.25. We could be 68 percent certain that the examinee’s true score would fall between 34.75 and 39.25 (1 standard deviation) and 95 percent certain that the true score would fall between 32.50 and 41.50 (2 standard deviations).
8-16. The date and time the report was generated.
8-17. Page number.
7.) Individual (student) Scores Report

Figure 9 below is an example of an individual student response.

<table>
<thead>
<tr>
<th>Objective</th>
<th>Points</th>
<th>%</th>
<th>Response</th>
<th>Correct Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. UNTITLED-G 1</td>
<td>0.00</td>
<td>0.00</td>
<td>B</td>
<td>[E]</td>
</tr>
<tr>
<td>2. UNTITLED-G 2</td>
<td>1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>3. UNTITLED-G 3</td>
<td>0.00</td>
<td>0.00</td>
<td>[E]</td>
<td></td>
</tr>
<tr>
<td>4. UNTITLED-G 4</td>
<td>0.00</td>
<td>0.00</td>
<td>BC [C]</td>
<td></td>
</tr>
<tr>
<td>5. UNTITLED-G 5</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>6. UNTITLED-G 6</td>
<td>0.00</td>
<td>0.00</td>
<td>A [D]</td>
<td></td>
</tr>
<tr>
<td>7. UNTITLED-G 7</td>
<td>0.00</td>
<td>0.00</td>
<td>B [C]</td>
<td></td>
</tr>
<tr>
<td>8. UNTITLED-G 8</td>
<td>0.00</td>
<td>0.00</td>
<td>C [B]</td>
<td></td>
</tr>
<tr>
<td>9. UNTITLED-G 9</td>
<td>1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>10. UNTITLED-G 10</td>
<td>0.00</td>
<td>0.00</td>
<td>D [E]</td>
<td></td>
</tr>
<tr>
<td>11. UNTITLED-G 11</td>
<td>1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>12. UNTITLED-G 12</td>
<td>1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>13. UNTITLED-G 13</td>
<td>1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>14. UNTITLED-G 14</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>15. UNTITLED-G 15</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>16. UNTITLED-G 16</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>17. UNTITLED-G 17</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>18. UNTITLED-G 18</td>
<td>1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>19. UNTITLED-G 19</td>
<td>1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>20. UNTITLED-G 20</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>21. UNTITLED-G 21</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>22. UNTITLED-G 22</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>23. UNTITLED-G 23</td>
<td>1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>24. UNTITLED-G 24</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>25. UNTITLED-G 25</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>26. UNTITLED-G 26</td>
<td>1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>27. UNTITLED-G 27</td>
<td>1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>28. UNTITLED-G 28</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>29. UNTITLED-G 29</td>
<td>1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>30. UNTITLED-G 30</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>31. UNTITLED-G 31</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>32. UNTITLED-G 32</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>33. UNTITLED-G 33</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>34. UNTITLED-G 34</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>35. UNTITLED-G 35</td>
<td>1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>36. UNTITLED-G 36</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>37. UNTITLED-G 37</td>
<td>1.00</td>
<td>100.00</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>38. UNTITLED-G 38</td>
<td>1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>39. UNTITLED-G 39</td>
<td>1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>40. UNTITLED-G 40</td>
<td>1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>41. UNTITLED-G 41</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>42. UNTITLED-G 42</td>
<td>1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>43. UNTITLED-G 43</td>
<td>1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>44. UNTITLED-G 44</td>
<td>1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>45. UNTITLED-G 45</td>
<td>1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>46. UNTITLED-G 46</td>
<td>1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
</tr>
</tbody>
</table>
9-1. Student name.
9-2. Social Security number.
9-3. Test. Name of exam (Quiz 1, Exam 2, Final, etc.)
9-4. Version. Which version test the student took. 0 = A, 1 = B, 2 = C, 3 = D.
9-5. Score. Percentage score. The raw score is indicated within parentheses.
9-6. Question number.
9-7. Question ID. The question ID is composed of two parts – the objective (in this case UNTITLED G) and the sequence number. To identify a specific question, the instructor will need to use both parts.
9-8. Points. The number of points a student received out of the number of points the question was worth.
9-9. %. The percentage of points a student received for each question. For T/F or MCS (multiple choice, single response) type questions, this will either be 0.00 or 100.00. For MCM (multiple choice, multiple response) type questions, a student might receive only 50% of the possible points.
9-10. Response [Correct Answer]. The student’s response is recorded in this column. If the student answered incorrectly, the correct response is bracketed on the right.
9-11. Date and time the report was generated.
9-12. Page number.

8.) Histogram of adjusted scores for a specific test
Figure 10 on the next page is an example of a histogram of adjusted scores for a specific test.
Statistics for EXAM 2 (100 Points Poss.)
Prepared by DR. TEACHER, NOVA-H. P. D.

**Figure 10**

<table>
<thead>
<tr>
<th>Class Average</th>
<th>Maximum</th>
<th>Minimum</th>
<th>Median</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>75.3</td>
<td>102.0</td>
<td>38.0</td>
<td>77.0</td>
<td>14.8</td>
</tr>
</tbody>
</table>
10-1. Title of report. This histogram will list as its title the name of the assignment providing the information. Included is the adjusted number of points possible.

10-2. Course number and date the report was printed.

10-3. Name of course instructor.

10-4. Students. Number of students in any given grade category.

10-5. Points. Divisions of point scores from lowest to highest. This can also be expressed as a percentage. In this histogram, 26 students scored between 30 and 35.

10-6. Class Average. The average of all the students’ scores.

10-7. Maximum. The highest score made by a student.

10-8. Minimum. The lowest score made by a student.

10-9. Median. The point value at which half the students scored higher and half the students scored lower.

10-10. Standard Deviation. The standard deviation gives information on the range of scores. 99% of all the scores fall within 3 standard deviations, it is a measure of dispersion about the mean. The smaller the standard deviation, the more students’ scores are about the same.

9. Histogram of course grade

Figure 11 on the next page is an example of a histogram for a course grade.
Figure 11

<table>
<thead>
<tr>
<th>Class Average</th>
<th>Maximum</th>
<th>Minimum</th>
<th>Median</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>84.4%</td>
<td>97.0%</td>
<td>60.7%</td>
<td>85.2%</td>
<td>8.1%</td>
</tr>
</tbody>
</table>
11-1. Title of report. This histogram will list as its title the semester in which the course occurs. The Testing Center labels semesters as Fall, Spring, or Summer plus the year.

11-2. Course number and date the report was printed.

11-3. Name of course instructor.

11-4. Students. Number of students in any given grade category.

11-5. Percentages. Divisions of percentage scores from lowest to highest. In this histogram, 23 students scored between 80% and 85%.

11-6. Class Average. The average of all the students’ scores.

11-7. Maximum. The highest score made by a student.

11-8. Minimum. The lowest score made by a student.

11-9. Median. The point value at which half the students scored higher and half the students scored lower.

11-10. Standard Deviation. The standard deviation gives information on the range of scores. 99% of all the scores fall within 3 standard deviations, it is a measure of dispersion about the mean. The smaller the standard deviation, the more students’ scores are about the same.

RESCORING YOUR TESTS

Occasionally an instructor will discover the need to rescore his/her exams. Circumstances which might necessitate a rescore are discovering that a key is incorrect, having questions successfully challenged, deciding (based on the statistical analysis) that a question is not “good”, or needing to raise an entire class’s scores. Each of these circumstances may be ameliorated by at least one method.

Discovering an incorrect key
Despite the best efforts of faculty and the Testing Center sometimes keys are incorrect. Fortunately, correcting keys is very simple. For both LXR-generated tests and instructor-generated tests which have more than one form, the instructor will need to tell the Testing Center what the correct letter response is for each version of the test. However, these corrections can be delivered by telephone; there is no need to bring in the students’ Scantrons or the keys (for instructor-generated tests).

LXR-generated tests are sometimes found to be missing an answer. If that occurs, please call it to the attention of the Testing Center and let us know the correct letter response for each version of the test.
Having questions successfully challenged/Deciding that questions are not good
Most of the colleges in the Health Professions Division have procedures for accepting challenges on test questions. A frequent student assertion on a challenge is that a multiple-choice question had more than one correct answer. If students’ challenges are accepted, an instructor has four ways to deal with them. The instructor may credit all students for the question, accept more than one answer as correct, weigh the question differently, or throw out the question. These are also the options available to an instructor who, upon reviewing the statistical analysis of his exam, decides that some of the questions were not clearly written or were not good discriminators.

Crediting all students for a question.
Although this option is popular with students (and the Testing Center because it is very easy), it is not the best way to resolve the situation. Crediting all the students for a bad question serves mainly to inflate student scores and give them a false sense of how they are doing in the class.

Accepting more than one answer as correct.
This option is the most frequently used in the Health Professions Division, however, it does have some drawbacks. One drawback is that the possibility of guessing correctly is doubled (or tripled if three answers are accepted). Students should not be rewarded for guessing. Also, from a statistical standpoint, it “muddies the waters” for deciding if a question is a good discriminator between the better students and weaker students.

Weighing the question differently.
Sometimes an instructor will receive complaints about a particular question and upon review, decide that the question was extraordinarily difficult. Such a decision might prompt him/her to remove the question from the regular part of the test (by changing the number of questions upon which the exam is based) and use it as extra credit for those few students who did get it correct. While this is very gratifying to the students who answered correctly, it is not often the best course of action. For one thing, it elevates the scores of the students who least need it and artificially raises the scores of those who were lucky guessers. Once again, it “muddies the waters” for deciding if a questions is a good discriminator between the better students and weaker students (because the only groups of students who will have answered correctly are the very best and the lucky few). And, from an emotional consideration, students who answered incorrectly will feel resentful and distrustful toward the instructor for including an inordinately difficult question on the test.

Throwing out the question.
From a statistical standpoint, this is the best option. Even though it will cause the other questions to be worth more, it is an acceptable trade-off because the remaining questions have all been shown to be good. By eliminating bad questions from the statistical analysis, the resulting analysis is a much more accurate reflection of the students’ abilities and the test’s discrimination and reliability.
**Needing to raise an entire class’s scores**

There are two main methods for raising an entire class’s scores: dropping lowest grades and curving. A professor choosing to raise class scores by dropping one or more of the lowest grades may wish to reconsider. Dropping lowest scores (though appealing to students) can have the unintended effects of giving students a false sense of accomplishment by artificially raising scores or of encouraging students to decrease their study of really difficult material, knowing that if they do poorly the grade will be dropped anyway.

Curving a class’s scores also demands careful consideration. Some of the colleges of the Health Professions Division have decided upon acceptable failure rates for their students, other colleges leave that to the discretion of individual instructors. A good rule of thumb could be that students falling below two standard deviations away from the mean would not pass. Once the decision is made for the placement of the cut-off point, then the necessary number of points are added to the lowest acceptable score to raise it to passing (70 on a 100 point scale for the Health Professions Division). This can be done on either a test-by-test basis or at the end of the semester. As an example, imagine that the lowest score above the cut-off was a 60. Ten points would need to be added to raise it to passing. Ten points would be added to every student’s score(s). A question arises with students who have scored above 90: should they be limited to 100 points or be given the full 10 points (raising their scores above 100)? It is up to the instructor’s or college’s discretion, but there is an important consideration. If the curving is being done on a test-by-test basis, and the curving allows for grades over 100, some students might be tempted to coast after a really high score and not learn later material as well.

**KEEPING YOUR GRADEBOOK**

The scoring and test-generating software used by the Testing Center, LXR, does not have a Gradebook module for maintaining students’ grades. Instead, it exports raw scores into a variety of Gradebook programs. The Testing Center uses Misty City Software’s Grademachine. Scores can also be keyboarded directly into Grademachine without scanning Scantron sheets.

**Manipulating scores**

*Grademachine* supports manipulating scores in a variety of ways.

- Any single assignment (*Grademachine*’s term for an exam, quiz, practical, etc.) may easily have points added.
- Scores for an assignment can be multiplied by any factor to make an exam worth the desired number of points. Consider a 52-question test in which every question was worth the same number of points (1), but which the professor would like to change from a 52-point test to a 100-point test. By multiplying the assignment’s points by 1.923, the scores are converted to a 100-point scale.
Types of assignments can be weighted differently. For example, consider if the testing for a semester consisted of 10 quizzes worth 10% of the grade, 2 practicals worth 40% of the grade and a midterm and final each worth 25% of the grade. *Grademachine* is able to calculate the course grade in seconds.

- Missed assignments can be marked as excused so students are not penalized for excused absences.
- Lowest scores can be dropped with a choice of either dropping the lowest score of the entire course or dropping the lowest score of a given type of assignment.
- Bonus points can be added easily and discretely (any column can be selected to not appear on a printed report).
- Attendance can be documented (late arrivals, excused, unexcused) and printed in reports by students’ posting ID’s. Negative points for unexcused absences can be totaled and subtracted from the course grade.
- Depending on instructor preference, course grades can be calculated either as a percentage of 100 or by a total number of points earned (or both). For example, a student earning 87 on each of two 100-point exams could have his/her course grade displayed as an 87, 174/200, or 174/200 (87%).

**Reporting options**

*Grademachine* offers a variety of report options.

- Reports can omit students based on grade criteria, absences, or personal selection.
- Reports can be arranged alphabetically by student names, numerically by Social Security number or assigned IDs, or by course grade.
- Reports can omit selected assignments, print only assignments with no course grade, or only a course grade with no assignments.
- Grades can be displayed with a decimal place or not.
- Course grades can be rounded or not.
- Subtotals of various types of assignments can be displayed or not and the course grade can be displayed or not.
- An attendance report can be generated which shows excused absences, late arrivals, and excused absences.
WHAT SHOULD I DO TO HELP THE TESTING CENTER HELP ME?

TESTING CENTER GUIDELINES

The Testing Center can help you accomplish your testing objectives and make your job easier and less time consuming. However, to receive the full benefits of the Testing Center, we recommend following these guidelines for creating your exams, having your exams scored and rescored, keeping your gradebook, and producing and analyzing your surveys/evaluations.

Two additional, general items regarding the Testing Center’s policies: 1.) Students are not allowed in the Testing Center. The usual student concerns of not seeing his/her score posted, wishing to change his/her secret ID number, or disputing a grade should all be handled by the instructor or departmental secretary. Please do not send students to the Testing Center. 2.) During the peak times of midterms and finals, the Testing Center places the creation of exams as its first priority. The next priority is scoring exams, followed by rescoring exams, gradebook alterations and finally evaluation creation and scoring. Instructors can greatly assist the Testing Center by submitting their exams as early as possible and by being patient during the most hectic times of the semester.

CREATING YOUR TESTS

Each instructor chooses to what extent he/she would like the Testing Center to assist him/her in the exam creation process. For some instructors the Testing Center serves mainly as a copy center and safe storage space for exams, for others (those who choose to take advantage of the LXR software), the Testing Center takes on a much more active role.

Guidelines for Instructor-Generated Tests

The most helpful thing an instructor can do for the Testing Center is submit his/her exam to be copied in a timely fashion. Most exams can be copied within a few hours, but it is strongly recommended that an instructor not wait that long to request copying services. Copiers break down, people get sick and the unexpected can happen at the worst time. Therefore, during midterms and finals (peak times), instructors must submit exams to be copied at least 48 hours before they are due to be administered. During non-peak times, please submit exams to be copied at least a full 24 hours in advance.

Instructor-generated test sequence of events.

1. Bring the exam to be copied to the Testing Center. For security reasons, do not use inter-office mail. If you would like to e-mail a file attachment of an exam, please send it to bkaner@nsu.nova.edu, jmoore@nsu.nova.edu or orosario@nova.edu. Faxes can be sent to 954-262-2252.
2. Fill in a Testing Center Work Order. Figure 12 on the next page is an example of a completed work order for an instructor-generated exam.
**TESTING CENTER WORK-ORDER**

- Please complete the following information, attach with test materials, and give to a Testing Center staff member.
- The Testing Center is located on the 5th floor of the Terry Administration Building, Room 1524.
- For consultation, please contact a Testing Center staff member: Beverly Kanan at extension 1522, Jacquelyn Moore at extension 1733, Rosario Ortiz at extension 1525.

1. **Today's date.**  Date the work or der is submitted.
2. **Course instructor.**  For courses with multiple instructors, use the name of the instructor who is responsible for the current exam.
3. **Contact person's name and phone number/extension.**  If an instructor is going to be unavailable or difficult to contact, please leave the secretary's name and extension. Beeper numbers can also be helpful.
4. **Course number.**  This is vitally important as all of the Testing Center's work is filed by course number. If we don't know the course number, we won't know where to look for your test scores or gradebook. For courses which are composed of different groups of students (for example, M-1's and D-1's taking a class together), please use the different course numbers for each group.
5. **Class.**  This allows the Testing Center to know which roster to use for gradebook functions. For courses which are composed of different groups of students (for example, M-1's and D-1's taking a class together), please indicate each group in the class.
6. **PREPARED BY TESTING CENTER?**  Check the no box.
7. **Test name or # Exam/ex ____- or- Quiz name or #____(☐ Final test/quiz on this roster for this semester)**

<table>
<thead>
<tr>
<th><strong>TEST GENERATOR REQUESTS</strong></th>
<th><strong>SCORE REQUESTS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Generate test from new test items.</td>
<td>☐ Score test.</td>
</tr>
<tr>
<td>☐ Copy test. Total number of copies needed: 20</td>
<td>☐ Re-score test.</td>
</tr>
<tr>
<td>☐ Generate test from items stored in item bank. (List item bank name and numbers on back.)</td>
<td>☐ Add students to previously scored test.</td>
</tr>
<tr>
<td>☐ Add new items to item bank. (List item bank name and numbers on back.)</td>
<td>Number of test keys:</td>
</tr>
<tr>
<td>☐ Print out items from item bank. (List item bank name and numbers on back.)</td>
<td>Number of student score sheets submitted:</td>
</tr>
<tr>
<td>Date requested for final review:</td>
<td>Total points test is worth:</td>
</tr>
<tr>
<td>Date/time test will be administered: 9/7/07</td>
<td>Item # Point values</td>
</tr>
<tr>
<td>Number of test items: 50</td>
<td></td>
</tr>
<tr>
<td>Submit on disc with file in Word® text only format:</td>
<td>☐ Additional fill-in essay points:</td>
</tr>
<tr>
<td>File name:</td>
<td>☐ Yes ☐ No</td>
</tr>
<tr>
<td>Test forms requested with scrambled answers?</td>
<td>Are these extra credit points? ☐ Yes ☐ No</td>
</tr>
<tr>
<td>☐ Yes ☐ No</td>
<td><strong>Select from the following special options that apply.</strong></td>
</tr>
<tr>
<td>Number of test forms requested: ☐ 1 ☐ 2 ☐ 3 ☐ 4</td>
<td>☐ Multiple responses accepted (either/or).</td>
</tr>
<tr>
<td>☐ Use colored paper for test.</td>
<td>Any of the following answers may be selected to give credit.</td>
</tr>
<tr>
<td>☐ Use colored paper for cover sheets.</td>
<td>Item # Responses accepted</td>
</tr>
<tr>
<td>Different color for each version? ☐ YES ☐ NO</td>
<td></td>
</tr>
<tr>
<td>☐ Use colored paper for back sheets.</td>
<td>☐ Multiple responses required.</td>
</tr>
<tr>
<td>Different color for each version? ☐ YES ☐ NO</td>
<td>Any of the following answers may be selected to give credit.</td>
</tr>
<tr>
<td>☐ Use special cover sheets. (Please attach.)</td>
<td>Item # Responses accepted</td>
</tr>
<tr>
<td>☐ Insert or append extra sheets. (Please attach.)</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 12**

- 32
Guidelines for LXR-generated tests
The most helpful thing an instructor can do for the Testing Center is give us enough time to process his/her request. Short, straightforward exams whose questions are submitted on disk can sometimes be created within a few hours; however, it is strongly recommended that instructors not wait that long to begin the process. **Minimum** processing time during peak times (midterms and finals) is 1 full week and during non-peak times is 3 full days.

The most helpful thing an instructor can do for himself or herself is categorize his/her questions. LXR item banks arrange questions alphabetically by categories which it calls “Objectives” and then numerically within each Objective. When no Objective is given to the Testing Center, the questions are labeled by the default beginning with Untitled A 001. Subsequent imported batches become Untitled B, Untitled C, etc. Instructors wishing to use Objectives have 20 characters with which to work. LXR also has several areas for sub-categories, each limited to 10 characters.

LXR test creation sequence of events for a test composed entirely of old questions.
1. Review the hard copy of the bank in which the questions are stored to determine which questions will be used in the new exam. If a hard copy is not available, call or stop by the Testing Center to request one. When referring to the stored questions, the Testing Center will need two pieces of information: the name of the item bank (which is the same as the course number) and the number of the question (usually something like Untitled A 001).
2. Fill in a work order. Indicate which questions will be used. See How to Complete a Work Order on pages 39-41.
3. The Testing Center will assemble the exam and call when it is ready to be proofed.
4. Review the proof of the exam. Pay special attention to whether or not each question has a check mark beside the correct answer and whether or not it is the correct answer which is so indicated. Please make any necessary corrections in red ink.

Figure 13 on the next page is an example of a proof. Notice that the correct answers are indicated with a check mark.
INSTRUCTIONS FOR COMPLETING YOUR SCANTRON

You must use a #2 pencil only.

Please print your name, class and course instructor on your scantron.

You must fill in the bubbles on your scantron, starting at far left, that correspond to your

NSU ID NUMBER.

OMIT THE "N" AND START WITH THE "0".

EXAMPLES: Your number is N00112233; you bubble 00112233.
Your number is N00011223; you bubble 00011223.

DO NOT USE YOUR SOCIAL SECURITY NUMBER.
DO NOT ADD OR SUBTRACT "0's" FROM YOUR NSU ID NUMBER.

You must fill in the bubbles on your scantron that correspond to your name, Last name, First name.

You must fill in the bubble on your scantron that corresponds to your test form, A, B, C, or D.

You must erase completely where necessary.

SELECT THE BEST ANSWER.

1. T √F Concerning the anterior compartment of the arm, innervation is from a nerve that arises from the lateral cord of the brachial plexus.

2. Each of the following muscles (of the lower extremity) is supplied primarily by the artery listed with it, EXCEPT for:
   A. √ Flexor digitorum longus - anterior tibial artery.
   B. Adductor brevis - deep femoral artery.
   C. Extensor digitorum brevis - dorsalis pedis artery.
   D. Vastus lateralis - femoral artery.
   E. Biceps femoris - perforating branches of the deep femoral artery.

3. A polio patient has had destruction of the anterior horn cells (motor cells) in the spinal cord at levels L2 - L3. Which of the following actions would be affected (i.e. which of the actions would be significantly weaker)?
   A. Extension at the knee joint
   B. Flexion of the thigh
   C. Extension of the leg
   D. Adduction at the hip joint
   E. √ All actions (A - D) would be affected significantly
5. Repeat the proofing (steps 3 and 4) until the exam is satisfactory.
6. Pick up exam package shortly before the exam is due to start. For early morning exams (before 8:00 a.m.), an instructor should pick up the exam package the day before and lock it in his/her office or other secure area.

LXR test creation sequence of events for a test composed entirely of new questions.

1. Type your questions and save the work on disk. LXR supports importing questions in text, but the questions have to be in a certain format. If an instructor has the ability to submit his/her questions in the correct format, tests can be created in a very short time. If an instructor cannot submit his/her questions in the proper format, the Testing Center has to reformat them and test creation takes much longer. If an instructor cannot submit his/her questions on disk, the Testing Center has to type them, which takes even longer. Please see the section How to Format Your Questions on pages 45-47. If illustrations are desired, save them in a separate file from the text only file in a graphics format supported by Windows (*.bmp, *.jpg).
2. Bring a hard copy of the exam with the correct answers and special formatting (bolding, italics, underlining, etc.) indicated and a disk with the questions saved on it to the Testing Center. For security reasons, do not send exams through inter-office mail.
3. Fill in a work order. See How to Complete a Work Order on pages 47-50.
4. The Testing Center will import the questions into LXR, assemble the exam, and call when it is ready to be proofed.
5. Review the proof of the exam. Pay special attention to whether or not each question has a check mark beside the correct answer and whether or not it is the correct answer which is so indicated. Please make any necessary corrections in red ink.

Figure 13 is an example of a proof. Notice that the correct answers are indicated with a check mark.

6. Repeat the proofing (steps 4 and 5) until the exam is satisfactory.
7. Pick up exam package shortly before the exam is due to start. For early morning exams (before 8:00 a.m.), an instructor should pick up the exam package the day before and lock it in his/her office or other secure area.

LXR test creation sequence of events for a test composed of both old and new questions.

1. Review the hard copy of the bank in which the old questions are stored to determine which questions will be used in the new exam. If a hard copy is not available, call or stop by the Testing Center to request one. When referring to the stored questions, the Testing Center will need two pieces of information: the name of the item bank (which is the same as the course number) and the number of the question (usually something like Untitled A 001).
2. Type the new questions and save the work on disk. LXR supports importing questions in text, but the questions have to be in a certain format. If an instructor has the ability to submit his/her questions in the correct format, tests can be created in a very short time. If an instructor cannot submit his/her questions in the proper format, the Testing Center has to reformat them and test creation takes much longer. If an instructor
cannot submit his/her questions on disk, the Testing Center has to type them, which takes even longer. Please see the section **How to Format Your Questions** on pages 45-47. If illustrations are desired, save them in a file separate from the text only file in a graphics format supported by Windows (*.bmp, *.jpg).

3. Bring a hard copy of the new questions with the correct answers and special formatting (bolding, italics, underlining, etc.) indicated and a disk with the new questions saved on it to the Testing Center. For security reasons, do not send exams through inter-office mail.

4. Fill in a work order. Indicate which questions from which items banks are to be used. Indicate the order in which questions are to appear. See **How to Complete a Work Order** on pages 47-50.

5. The Testing Center will import the questions into LXR, assemble the exam, and call when it is ready to be proofed.

6. Review the proof of the exam. Pay special attention to whether or not each question has a check mark beside the correct answer and whether or not it is the correct answer which is so indicated. Please make any necessary corrections in red ink.

Figure 13 is an example of a proof. Notice that the correct answers are indicated with a check mark.

7. Repeat the proofing (steps 5 and 6) until the exam is satisfactory.

8. Pick up exam package shortly before the exam is due to start. For early morning exams (before 8:00 a.m.), an instructor should pick up the exam package the day before and lock it in his/her office or other secure area.

**How to Format Your Questions**

This section is intended for people who use Microsoft Word. If you are using another program, please adapt these suggestions to best fit that program.

1. Begin by typing your questions without any formatting at all. Do not include italics, bolding, underlining, superscripts, subscripts, special characters, tabs, or changes in font size.

2. Save your document as text only (.txt extension).

3. Adjust some of the special formatting features of Word.

In order to see your formatting more easily:
- Select Tools ⇒ Select Options ⇒ Select View ⇒ Go to the Nonprinting characters area
- Put check marks in the boxes next to Tab characters, Spaces, and Paragraph marks.
- Click on the OK button at the bottom of the box.

In order to maintain your left margins:
- Select Tools ⇒ Select Options ⇒ Select Edit
- Remove the check mark in the box next to Tabs and back space set left indent
- Click on the OK button at the bottom of the box.
In order to turn off the auto-formatting for bullets:
• Select Format ⇒ Select Bullets and Numbering ⇒ Select Bulleted
• Highlight the box marked None
• Click on the OK button at the bottom of the box.

In order to turn off the auto-formatting for numbering:
• Select Format ⇒ Select Bullets and Numbering ⇒ Select Numbered
• Highlight the box marked None
• Click on the OK button at the bottom of the box.

In order to turn off the auto-formatting for outline:
• Select Format ⇒ Select Bullets and Numbering ⇒ Select Outline Numbered
• Highlight the box marked None
• Click on the OK button at the bottom of the box

4. Your formatted questions should look like these:

1. • Which of the following statements concerning the femoral triangle is correct?
   A. • The femoral vein lies medial to the femoral nerve and the femoral artery
   B. • The pectineus and adductor longus muscles form the floor of the triangle
   C. • The sartorius muscle forms the medial border of the triangle
   D. • The obturator nerve (anterior division) is part of the “contents” of the triangle
   E. • The rectus femoris muscle forms the roof of the triangle
   Answer: • A

2. • Each of the following muscles (of the lower extremity) is supplied primarily by the artery listed with it, EXCEPT for:
   A. • Vastus intermedius – deep femoral artery
   B. • Tibialis anterior – anterior tibial artery
   C. • Extensor hallucis brevis – dorsalis pedis artery
   D. • Flexor digitorum longus – posterior tibial artery
   E. • Peroneus longus – perforating branches of the peroneal artery
   Answer: • A

3. • Concerning the anterior compartment of the arm, innervation is from a nerve that arises from the lateral cord of the brachial plexus.
   Answer: • T

4. • Use this information for the next five questions.

CLINIC CASE #2
A 61-year old male presents to the clinic with a 36-hour history of nausea, vomiting, and dizziness. He attended an evening picnic on Labor Day where he enjoyed hot dogs, deviled eggs, potato salad, and ice cream. He stated that the next morning he woke up nauseated and began having watery diarrhea every hour. This morning the diarrhea has
continued and he has had one episode of vomiting. The patient denies any blood in the vomitus nor did he notice any blood in the diarrhea. Patient states he felt some mild dizziness only after he vomited.

5. Of the following, which would be the most important question to ask the patient?
   A. Are you experiencing any chest pain?
   B. Does anyone else from the picnic have similar symptoms?
   C. Have you developed a cough?
   D. Did you consume any alcoholic beverages or controlled substances within the past twenty-four hours?
   E. When was the last time you saw a doctor?

Answer: B

Please note:
- The format for the stem of a question is number . question.
- For long questions, allow the text to wrap without adding any enters or tabs.
- Do not put a line of space between a question and the responses.
- The format for multiple choice question responses is capital letter . response.
- For long responses, allow the text to wrap without adding any enters or tabs.
- After the responses, the format for the answer is Answer : capital letter.
- Between questions there is only one line of space.
- Question 3 shows the format for a true/false question.
- Number 4 is not a question but rather information pertaining to several questions. LXR terms this “an instruction”. On the test it will not be numbered, but formatting requires that it be numbered to be imported.
- The process of formatting the responses can easily be automated through the use of macros. See Jacquelyn Moore for a quick lesson in creating macros.

How to Complete a Work Order
Figure 14 on the next page is an example of a completed work order for an LXR-generated exam.
**TESTING CENTER WORK-ORDER**

- Please complete the following information, attach test materials, and give to a Testing Center staff member.
- The Testing Center is located on the 5th floor of the Terry Administration Building, Room 1524.
- For consultation, please contact a Testing Center staff member:
  - Beverly Riner at extension 1522, Jacquelyn Moore at extension 1733, Roxana Ortiz at extension 1525.

1. Today’s date: __10/17/07__
2. CIRCLE SEMESTER: __Fall__ Winter/Spring Summer
3. Course instructor: __Dr. Professor__
4. Contact person’s name and phone number/extension: __Dr. Professor __0301 / Pat Coordinator __0022__
5. Course number (3 prefix & 4 digit number, according to the NSU catalogue): __A NA __5420__
6. PREPARED BY TESTING CENTER?: __Yes__ __No__
7. Test name or # __Exam 3__ or Quiz name or # ____________________
   (® Final test/quiz on this roster for this semester)

<table>
<thead>
<tr>
<th>TEST GENERATOR REQUESTS</th>
<th>SCORE REQUESTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Generate test from new test items.</td>
<td>□ Score test.</td>
</tr>
<tr>
<td>□ Copy test. Total number of copies needed: <strong>120</strong></td>
<td>□ Re-score test.</td>
</tr>
<tr>
<td>□ Generate test from items stored in item bank. (List item bank name and numbers on back.)</td>
<td>□ Add students to previously scored test.</td>
</tr>
<tr>
<td>□ Add new items to item bank. (List item bank name and numbers on back.)</td>
<td>Number of test keys: ____________________________</td>
</tr>
<tr>
<td>□ Print out items from item bank. (List item bank name and numbers on back.)</td>
<td>Number of student score sheets submitted: ____________________________</td>
</tr>
<tr>
<td>Date requested for final review: <strong>10/25/07</strong></td>
<td>Total points test is worth: ____________________________</td>
</tr>
<tr>
<td>Date/time test will be administered: <strong>11/13/07 1PM</strong></td>
<td>Item # ____________________________ Point values ____________________________</td>
</tr>
<tr>
<td>Number of test items: <strong>100</strong></td>
<td>Additional fill-in essay points: ____________________________</td>
</tr>
<tr>
<td>Submit on disc with file in Word® text only format:</td>
<td>Are these extra credit points? <strong>Yes</strong> <strong>No</strong></td>
</tr>
<tr>
<td>File name: <strong>Anatomy Exam 3</strong></td>
<td>Select from the following special options that apply:</td>
</tr>
<tr>
<td>Test forms requested with scrambled answers?</td>
<td>□ Multiple responses accepted (either/or).</td>
</tr>
<tr>
<td>□ Yes <strong>No</strong></td>
<td>Any of the following answers may be selected to give credit: Item # ____________________________ Responses accepted ____________________________</td>
</tr>
<tr>
<td>Number of test forms requested: <strong>1</strong> <strong>2</strong> <strong>3</strong> <strong>4</strong></td>
<td>□ Multiple responses required.</td>
</tr>
<tr>
<td>□ Yes <strong>No</strong></td>
<td>Any of the following answers may be selected to give credit: Item # ____________________________ Responses accepted ____________________________</td>
</tr>
<tr>
<td>□ Credit all students for items #: ____________________________</td>
<td>□ Gradebook alteration requests. (Explain on back.)</td>
</tr>
<tr>
<td>□ Omit item #: ____________________________</td>
<td>□ Other requests. (Explain on back.)</td>
</tr>
<tr>
<td>□ Use colored paper for test.</td>
<td>____________________________</td>
</tr>
<tr>
<td>□ Use colored paper for cover sheets.</td>
<td>____________________________</td>
</tr>
<tr>
<td>□ Use colored paper for back sheets.</td>
<td>____________________________</td>
</tr>
<tr>
<td>□ Use special cover sheets. (Please attach.)</td>
<td>____________________________</td>
</tr>
<tr>
<td>□ Insert or append extra sheets. (Please attach.)</td>
<td>____________________________</td>
</tr>
</tbody>
</table>
14-1. Today’s date. Date the work order is submitted. Circle the semester for this order. (In some cases i.e. a remediation exam, the semester circled may not be the current semester, but the previous semester.)

14-2. Course instructor. For courses with multiple instructors, use the name of the instructor who is responsible for the current exam.

14-3. Contact person’s name and phone number/extension. If an instructor is going to be unavailable or difficult to contact, please leave the secretary’s name and extension. Beeper numbers can also be helpful.

14-4. Course number. This is vitally important as all of the Testing Center’s work is filed by course number. If we don’t know the course number, we won’t know where to look for your item bank, tests, or gradebook. For courses which are composed of different groups of students (for example, M-1’s and D-1’s taking a class together), please use the different course numbers for each group.

14-5. Class. This allows the Testing Center to know which roster to use for gradebook functions. For courses which are composed of different groups of students (for example, M-1’s and D-1’s taking a class together), please indicate each group in the class.

14-6. PREPARED BY TESTING CENTER? Check the yes box.

14-7. Test #, Quiz #, Final. This will be the name of the assignment both within LXR and the gradebook program. By checking the Final box, the Testing Center will know to print a final course grade after scoring.

14-8. Generate test from new test items. Check this box if the test will be composed (either partially or entirely) of new questions entered into the item bank.

14-9. Copy test. Fill in number of copies needed. It is recommended that instructors ask for a few more than they will actually use.

14-10. Generate test from items stored in item bank. Check this box if the test will be composed (either partially or entirely) of questions already in the item bank. When referring to the stored questions, the Testing Center will need two pieces of information: the name of the item bank (which is the same as the course number) and the number of the question (usually something like Untitled A 001). List the questions to be included on the exam on the back of the form.

14-11. Add new items to item bank. Check this box if new questions are to be added to an item bank. It is not necessary to wait until just before an exam to add questions, they can be added at any time.

14-12. Print out items from item bank. Check this box if a hard copy of questions in the LXR format is desired. This request can usually be handled in a short amount of time, but the Testing Center would ask that it not be made very frequently as it ties up the printer and uses a lot of paper.

14-13. Date requested for final review. Once the Testing Center has entered questions into an item bank and the test is assembled, the instructor will be called to come proof his/her exam. If the instructor has special circumstances (such as trying to prepare an exam before being out of town for several days), this is the area to highlight that request. Otherwise, a proof will be prepared as soon as possible.

14-14. Date/time test will be administered. Helpful for determining urgency during peak times (midterms and finals).

14-15. Number of test items. Serves as a safeguard that all questions have been entered.
14-16. File name. If the disk containing the questions has more than one file on it, please use this line to indicate which file is to be used.

14-17. Test forms requested with scrambled answers? Check the yes box if different forms of the exam are desired. LXR can create up to four different versions of an exam to discourage cheating. The questions remain in the same order, but the order of the responses is changed for each version. LXR allows complete control over the scrambling process. Responses can be scrambled or not, or any portion of the responses can be scrambled (only A & B, A through C, A through D, or A through E).

14-18. Number of test forms requested. The maximum is four, but it is an instructor’s choice to use 3, 2, or just 1 version.

14-19. Special requests. The Testing Center’s copier can easily attach different colored cover sheets to the front, back or front and back of copy sets. Some instructors who teach different groups of students within the same class use color-coding to distinguish the groups. Another request might be to insert or append extra pages of charts or blank sheets for calculations or recording answers. Some professors insert cartoons within the body of an exam to relieve tension. This is the area to indicate such requests.

For all instructors - tips on administering tests
Before administering an exam, please encourage, exhort, instruct, threaten and nag your students to fill in their Scantron sheets correctly. The main points:

- Use only pencils – the Testing Center’s scanners cannot read ink.
- Fill in Social Security numbers correctly. Start in the left corner and do not skip any columns. When done correctly the last column on the right will be blank.
- Write in name as well as bubbling it in.
- Do not fold, tear, or puncture the Scantron form - the Testing Center’s scanners have difficulty reading Scantrons which are dog-eared, torn, folded, or stapled.
- Do not doodle in the margins – the Testing Center’s scanners have difficulty reading Scantrons which are marked in extraneous areas (especially around the bar codes).

The Testing Center has prepared a brief (10 minute) lecture on how to fill in a Scantron and some of the common problems students face with the Testing Center. If an instructor would like to have his/her class receive this lecture, please call Jacquelyn Moore at extension 1733 to arrange a time.

SCORING YOUR TESTS
The Testing Center scores exams on a first-come, first-served basis usually within a few hours of receipt. However, certain circumstances may force exam scoring to take longer; such circumstances may be: tests for classes composed of mixed groups of students, tests for classes with several years of students, tests with teacher-scored sections, and tests with unusual scoring requirements. During midterms and finals, exam creation takes precedence over scoring, but scoring is still usually accomplished within a week of receipt. Once exams have been scored, the students’ Scantron sheets are returned to the
instructor. **Instructors are responsible for keeping their students’ Scantrons for the length of time determined by their department head or dean.**

**Scoring instructor-generated tests**
The instructor will first need to create a key for each version of the test. When creating the key(s), please do not write in the area labeled ID Number. The instructor must separate the different versions of his/her students’ exams and bring them to the Testing Center.

If a student did not mark which version test he/she took, please try to find out by examining the students’ test booklets (providing that students were asked to write their names on their booklets). If that doesn’t indicate which version the student took, please flag the student’s Scantron and alert the Testing Center. The Testing Center will score the student’s test in each version and give him/her the highest score (unless otherwise directed by the instructor – some instructors fail or penalize students who are negligent in marking their forms).

If the instructor already filled in a work order to have his/her exam copied, he/she can ask the Testing Center to retrieve it and then simply continue filling in the lower right side of the same form. Otherwise, an instructor will need to fill in the top and lower right side of a Testing Center Work Order. Please see **How to Complete a Testing Center Work Order for Scoring** on pages 43-45.

**Scoring LXR-generated tests**
The instructor will need to bring his/her students’ Scantron sheets to the Testing Center. There is no need to create keys or to separate students’ Scantron sheets by version. Ask the Testing Center to retrieve the work order that was filled out to have the test created and simply fill in the lower right side of it (unless this was already done).

**How to complete a Testing Center Work Order for scoring**
Figure 15 on the next page is an example of a work order filled in for scoring either an instructor-generated exam or an LXR-generated exam.
Figure 15

TESTING CENTER WORK-ORDER

- Please complete the following information, attach with test materials, and give to a Testing Center staff member.
- The Testing Center is located on the 5th floor of the Terry Administration Building, Room 1524.
- For questions, please contact a Testing Center staff member: Beverly Kazar at extension 1522; Jacqueline Moore at extension 1733; Rosario Ortiz at extension 1525.

| 1 | Today’s date: 2/27/10 | CIRCLE SEMESTER: Fall Winter/Spring Summer |
| 2 | Course instructor: Dr. Teacher |
| 3 | Contact person’s name and phone number/extension: Dr. Teacher x2001/Sally Coordinator x2002 |
| 4 | Course number (3 prefix & 4 digit number, according to the NSU catalogue): |
| 5 | CLASS - CIRCLE ALL THAT APPLY: BV/S1 BV/S2 BSN RN1 RN2 D1 D2 D3 D4 PG1 PG2 |
| 6 | PREPARED BY TESTING CENTER? yes no |
| 7 | □ Test name or # - or - Quiz name or # Quiz 2 (Final test/quiz on this roster for this semester) |

<table>
<thead>
<tr>
<th>TEST GENERATOR REQUESTS</th>
<th>SCORE REQUESTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Generate test from new test items.</td>
<td>□ Score test.</td>
</tr>
<tr>
<td>□ Copy test. Total number of copies needed:</td>
<td>□ Re-score test.</td>
</tr>
<tr>
<td>□ Generate test from items stored in item bank. (List item bank name and numbers on back.)</td>
<td>□ Add students to previously scored test.</td>
</tr>
<tr>
<td>□ Add new items to item bank. (List item bank name and numbers on back.)</td>
<td>Number of test keys: 3</td>
</tr>
<tr>
<td>□ Print out items from item bank. (List item bank name and numbers on back.)</td>
<td>Number of student score sheets submitted: 118</td>
</tr>
<tr>
<td></td>
<td>Total points test is worth: 100</td>
</tr>
</tbody>
</table>
| | Item #
| | 1 - 10 5 pts each
| | 11 - 25 3 pts each |
| | 26 - 35 4 pts each |
| | 36 - |
| | □ Additional fill-in/essay points? □ Yes □ No |
| | Are these extra credit points? |
| | Select from the following special options that apply. |
| | □ Multiple responses accepted (either/or). |
| | Any of the following answers may be selected to give credit. |
| | Item # Responses accepted |
| | □ Credit all students for items #: |
| | □ Omit item #: |
| | □ Gradebook alteration requests. (Explain on back.) |
| | □ Other requests. (Explain on back.) |

43
15-1. Today’s date. Date the work order is submitted. Circle the semester for this order. (In some cases i.e. a remediation exam, the semester circled may not be the current semester, but the previous semester.)

15-2. Course instructor. For courses with multiple instructors, use the name of the instructor who is responsible for the current exam.

15-3. Contact person’s name and phone number/extension. If an instructor is going to be unavailable or difficult to contact, please leave the secretary’s name and extension. Beeper numbers can also be helpful.

15-4. Course number. This is vitally important as all of the Testing Center’s work is filed by course number. If we don’t know the course number, we won’t know where to look for your item bank, tests, or gradebook. For courses which are composed of different groups of students (for example, M-1’s and D-1’s taking a class together), please use the different course numbers for each group.

15-5. Class. This allows the Testing Center to know which roster to use for gradebook functions. For courses which are composed of different groups of students (for example, M-1’s and D-1’s taking a class together), please indicate each group in the class.

15-6. PREPARED BY TESTING CENTER? Check the yes box for LXR-generated exams, check the no box for instructor-generated exams.

15-7. Test #, Quiz #, Final. This will be the name of the assignment within the gradebook program. By checking the Final box, the Testing Center will know to print a final course grade after scoring.

15-8. Score test. Check this box to indicate that the test should be scored.

15-9. Add students to previously-scored test. Check this box to indicate that additional students will be added to a test. If the students are taking a test which is exactly the same as their classmates’, there is no need to bring the keys – they are stored in the computer.

15-10. Number of test keys. This is the same as the number of versions of the test.

15-11. Number of student score sheets submitted. This number is not essential to the Testing Center, but it can help an instructor resolve disputes with students who claim that they took the exam but the Testing Center lost (or failed to scan) their Scantrons.

15-12. Total points test is worth.

15-13. Use this area to assign point values to questions. The example shown here is rather extreme. A more common request might read: Item #s 1-50 2 points each.

15-14. Additional fill-in/essay points. Some instructors include questions on their exams which cannot be scored on the Testing Center’s scanners (fill in the blank or essay questions). For questions like that, the instructor will need to grade them by hand and then report the scores back to the Testing Center. Those points can either serve as a regular part of the score or as extra credit. Consider these two examples. **Example One.** An instructor gives a 40 question exam, assigns a point value of 1 to each question, and includes a section of essay questions. To make the exam worth 100 points, the essay section would have to be worth 60 points. **Example Two.** An instructor gives a 40 question exam, assigns a point value of 2.5 to each question, and includes a section of essay questions. The instructor
would have to decide whether to make the exam worth 100 points and have the essay questions count as extra credit (and if so, how much) or to have the exam worth more than 100 points (and if so, how much the essay portion would be worth.). This section along with the section detailed above is the area to indicate these decisions.

15-15. *Multiple responses required.* Check this box if certain questions require more than one response to receive full credit. LXR can assign partial credit for incomplete (but correct) answers. Multiple response questions have two areas for special consideration. First, using this feature could result in those questions being worth more than single-response questions on the test. Second, the instructor must decide how to handle guessing. If students know that they will receive partial credit for each correct answer and not be penalized for marking incorrect answers, then an intelligent student would adopt the strategy of marking all answers. To combat that strategy, LXR can give negative points for an incorrect response and positive points for the correct response. However, in the interest of fairness, students should be forewarned that they will be penalized for marking answers which are not correct (guessing). The students should be warned because this type of scoring is very different from that customarily used by the Testing Center. Ordinarily, the program awards positive points for a correct answer and zero points for an incorrect answer.

The other parts of this form will be discussed in **RESCORING YOUR TEST** and **KEEPING YOUR GRADEBOOK**.

**RESCORING YOUR TESTS**

During non-peak times, exams are rescored on a first-come first-served basis with a usual turn around time of less than a day. However, during midterms and finals, rescoring takes a very low priority. When an instructor decides to ask the Testing Center to rescore an exam, he/she may either call in the request or stop by and ask. There is no need to bring in new or corrected keys or the students’ Scantron sheets.

**Testing Center Work Order for rescoring**

Figure 16 on the next page is an example of a portion of a work order filled in for rescoring either an instructor-generated exam or an LXR-generated exam.
Figure 16

**TESTING CENTER WORK-ORDER**

- Please complete the following information, attach with test materials, and give to a Testing Center staff member.
- The Testing Center is located on the 9th floor of the Terrell Administration Building, Room 1524.
- For consultation, please contact a Testing Center staff member.

- Beverly Rafter at extension 1522, Jacqueline Moore at extension 1733, Rosario Ortiz at extension 1925.

Today's date: **8/19/87**

**CIRCLE SEMESTER:** Fall  Winter/Spring  Summer

Course instructor:  Dr. Professor

Contact person's name and phone number/extension:  Dr. Professor x 2001/Mary Coordinator x 2002

Course number (3 prefix & 4 digit number, according to the NSU catalogue):  AN 54.20

<table>
<thead>
<tr>
<th>CLASS</th>
<th>CIRCULAR ALL THAT APPLY</th>
<th>BHVS1</th>
<th>BHVS2</th>
<th>BSN</th>
<th>RN1</th>
<th>RN2</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
<th>PG1</th>
<th>PG2</th>
<th>PA1</th>
<th>PA1-AD</th>
<th>PA2</th>
<th>Ph1</th>
<th>Ph1-INT</th>
<th>Ph2</th>
<th>Ph2-INT</th>
<th>Ph3</th>
<th>Ph3-INT</th>
<th>OPT1</th>
<th>OPT2</th>
<th>Special</th>
</tr>
</thead>
<tbody>
<tr>
<td>M1</td>
<td>M2</td>
<td>M3/4</td>
<td>MB51</td>
<td>MB52</td>
<td>MPH1</td>
<td>MPH2</td>
<td>OD1</td>
<td>OD2</td>
<td>OD3</td>
<td>OD4</td>
<td>AA1</td>
<td>AA2</td>
<td>CFT1</td>
<td>CFT2</td>
<td>Special</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PA1</td>
<td>PA1-AD</td>
<td>PA2</td>
<td>Ph1</td>
<td>Ph1-INT</td>
<td>Ph2</td>
<td>Ph2-INT</td>
<td>Ph3</td>
<td>Ph3-INT</td>
<td>OPT1</td>
<td>OPT2</td>
<td>Special</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

PREPARED BY TESTING CENTER?  □ Yes  □ No

☐ Test name or # __________ or ☐ Quiz name or # __________ (☐ Final test/quiz on this roster for this semester)

<table>
<thead>
<tr>
<th>TEST GENERATOR REQUESTS</th>
<th>SCORE REQUESTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate test from new test items.</td>
<td>□ Score test.</td>
</tr>
<tr>
<td>Copy test. Total number of copies needed: __________</td>
<td>□ Re-score test.</td>
</tr>
<tr>
<td>Generate test from items stored in item bank. (List item bank name and numbers on back.)</td>
<td>□ Add students to previously scored test.</td>
</tr>
<tr>
<td>Add new items to item bank. (List item bank name and numbers on back.)</td>
<td>Number of test keys: __________</td>
</tr>
<tr>
<td>Print out items from item bank. (List item bank name and numbers on back.)</td>
<td>Number of student score sheets submitted: __________</td>
</tr>
<tr>
<td>Date requested for final review: __________</td>
<td>Total points test is worth: __________</td>
</tr>
<tr>
<td>Test forms requested with scrambled answers?</td>
<td>Item #</td>
</tr>
<tr>
<td>Yes  □ No</td>
<td>__________</td>
</tr>
<tr>
<td>Number of test forms requested: 1 2 3 4</td>
<td>Additional fill-in/essay points?  □ Yes  □ No</td>
</tr>
<tr>
<td>SPECIAL REQUESTS:</td>
<td>Are these extra credit points?</td>
</tr>
<tr>
<td>Use colored paper for test.</td>
<td></td>
</tr>
<tr>
<td>Use colored paper for cover sheets.</td>
<td></td>
</tr>
<tr>
<td>Different color for each version?  □ YES  □ NO</td>
<td></td>
</tr>
<tr>
<td>Use colored paper for back sheets.</td>
<td></td>
</tr>
<tr>
<td>Different color for each version?  □ YES  □ NO</td>
<td></td>
</tr>
<tr>
<td>Use special cover sheets. (Please attach.)</td>
<td></td>
</tr>
<tr>
<td>Insert or append extra sheets. (Please attach.)</td>
<td></td>
</tr>
</tbody>
</table>

Select from the following special options that apply.

- Multiple responses accepted (either/or).
- Any of the following answers may be selected to give credit.
  - Item # | Responses accepted |
  - Form A # 1a | B or C |
  - Form C # 1a | C or E |
- Multiple responses required.
- Any of the following answers may be selected to give credit.
  - Item # | Responses accepted |

- Credit all students for items #: 2 3
- Omit item #: 7
- Gradebook alteration requests. (Explain on back.)
- Other requests. (Explain on back.)
16-1. This top section will have been completed when the exam was first submitted to be scored.

16-2. Re-score test. Check this box to indicate a test is to be rescored.

16-3. Multiple responses accepted. Occasionally an instructor will find (or be challenged and realize) that he/she inadvertently used a question which had more than one correct answer. Accepting more than one answer as correct is a very common method for dealing this situation. Indicate which questions are affected and write the question number and accepted answers for each version of the test. Use the back of the sheet if necessary.

16-4. Credit all. Occasionally an instructor will decide that a question is unsalvageable. At that point, he/she must decide whether to give credit to all students for the question or to omit the question from the exam (thereby increasing the value of the remaining questions). Although crediting all the students for a question is popular both with the students and with the Testing Center (because it is very easy to do), the instructor may wish to consider that such an action could have the unintended effect of artificially raising his/her students’ scores and giving them a false sense of their accomplishments. If an instructor wishes to credit all students, he/she need only write the question number(s) in this space or, if the question number(s) is/are different for the different versions then the question number(s) and the version.

16-5. Omit questions. From a statistical standpoint, this is the preferred method for dealing with bad questions. The instructor should be aware that using this method will result in the remaining questions being worth more points. If an instructor wishes to omit questions, he/she need only write the question number(s) in this space or, if the question number(s) is/are different for the different versions then the question number(s) and the version.

16-6. Gradebook alteration requests. Check this box to indicate that the Testing Center should alter the Gradebook. Gradebook alterations might include such actions as dropping lowest scores, excusing certain students for absences, weighting different types of scores (for example quizzes make up 10% of the total course grade and the midterm and final are each worth 45%), adding points to certain students or an entire class, or asking a group of student scores to be added to the Gradebook manually. Because these requests can become very involved, instructors should feel free to use the entire back of the form.

16-7. Other requests. Check this box to indicate that you would like the Testing Center to perform some other action not listed on this form. A common “Other request” is to export students’ grades on a disk in Excel format.

**KEEPING YOUR GRADEBOOK**

The Testing Center’s Gradebook software program, *GradeMachine*, can be a harried instructor’s best friend. It easily calculates, rounds, and averages students’ scores, and prints its reports in a variety of formats.
Provided that an instructor writes his/her Gradebook requests on a work order, the Testing Center can be of great service in documenting the changes. Old work orders are kept in storage and can be retrieved to clarify disputes and misunderstandings. Occasionally students will not challenge a grade until near the time of their graduation, by which time the best of memories can grow fuzzy. Old work orders coupled with the Gradebook, which is also saved, can help resolve this situation.

**HOW CAN I WRITE BETTER TESTS?**

**TESTING AND EXAMINATIONS**

By Patrick Hardigan, Ph.D.

**The Trouble with Testing...**

The importance of grades to students, (to academic admissions committees, to students' families and potential employers) cannot be understated. During the years at university a student's concept of self-worth and intellect is based largely on grades. Grades become a matter of public record, and frustration about testing methods can impair student/instructor rapport, often blocking learning, according to W.J. McKeachie in 'The Complete Academic.' One answer to the problem, he says, is to construct fair and appropriate tests.

There is some evidence that we actually like to be tested! In his chapter on testing in 'The Craft of Teaching',² K.E. Eble points to the popularity of newspaper quizzes, crossword puzzles and television quiz shows as evidence that we actually find pleasure in learning, and determining what we know.² Why, then, do we alienate students by testing them? Eble believes that "a great deal of sloppy testing exists because the true purpose of tests is to arrive at and defend a grade."² Rather, he says, the instructor should ask "Why am I testing," "How am I testing," and "What result am I getting?"²

In addressing the three questions which he sets out, the author looks at student motivation, grading, and tests as diagnostic tools. Test construction, he claims, usually develops through happenstance, since few academics are skilled in test design. Even some basic rules of learning theory are largely ignored in the testing situation.²

Testing ought to be a means of providing feedback, yet exams are scheduled after classes have concluded, and the important effects of feedback are lost. "Giving feedback," he says, "is as necessary and as worthy of care, intelligence and imagination as making up the test in the first place."² Eble suggests too, that excessive stress is harmful to performance, and that final exams deliberately foster such stress.²
His article concludes with a number of helpful suggestions, which are listed below:
1. Use a variety of testing methods.
2. Always give feedback, promptly if possible.
3. Tests should be more for learning and for motivating than for measuring. All three are useful.
4. Regard the absolute worth and accuracy of testing with suspicion.
5. Reduce in any way you can the threat tests pose.
6. Don't grade all tests.
7. Clarify test objectives both before and after, with yourself and with students.
8. Be honest, open, and fair. Discuss tests both before and after.
9. Let students be makers as well as takers of tests.
10. Don't stress the trivial just because it is so easy to test.
11. Surprise quizzes and tests, which can’t be completed in the given time, may serve the teacher's ego more than the student's learning.
12. Be imaginative as well as careful, balanced, and precise.
13. Be generous.

Accentuating the Positive...
In a recent College Teaching article, authors Miriam McMullen-Pastrick and Maryellen Gleason look at examinations as a tool to promote, rather than simply assess learning. "All that can be said for most exams," the authors write, "is that they attempt to measure at a particular juncture in time, a student's ability to demonstrate mastery of some information and some skills. Put another way, exams are not the solitary apex of academic life." Although exams can promote learning, they often fail to do so. The authors encourage instructors "to adopt a philosophy of exams, to create a set of objectives, and to communicate the essence of both" to students.

In addition to a listing of essentials, like "how many questions" or "how much does the exam count," academics should tell students what they believe about exams, what the goal is, and what the grade will mean. In this way, say the authors, students can more readily place exams in the larger context of course goals.

The Multiple-Choice Exam
Two excellent papers have been published to provide help in designing multiple-choice exams. They acknowledge the problems inherent in designing such tests - clear, explicit, factual questions test recall, but do not challenge students to think. Only the most difficult questions to design can test abilities to integrate and synthesize.

One of these guides to writing multiple-choice exams appears in the November 1987 issue of the ‘The Teaching Professor.” The two highlights of this article are advice about dealing with irate students after exams, and a "Testing the Test" checklist, which helps you to assess the quality of your multiple-choice exams. A partial list of the 15 items follows:
• When possible, state the item as a direct question, rather than as an incomplete statement.
• Make the alternatives grammatically parallel with each other, and consistent with the stem.
• Use at least four alternatives for each item.
• Use the alternatives "none of the above" and "all of the above" sparingly. When used, such alternatives were occasionally the right answer.

A more in-depth approach to multiple-choice exams is the objective of Idea Paper No 16 from the Center for Faculty Education and Development, Kansas State University. As in the previous paper, the authors stress that well-designed exams are important teaching tools. They go on to look carefully at the construction of multiple-choice items, which ought to test knowledge, comprehension, application, analysis, synthesis and evaluation (Bloom's Taxonomy, 1956). Both strengths and limitations of multiple choice tests are considered here, followed by recommendations on the appropriate use, preconditions of writing, constructions and layout of multiple-choice exams. Among the 34 recommendations for constructing the exams are:
• Spread the work across time, review and revise.
• Avoid pitfalls of writing items that test only recall.
• State problem or ask questions in the positive form.
• Avoid grammatical inconsistencies between the stem and the options.
• Arrange options in a logical order: (chronologically, alphabetically, etc.).

The Matching-Items Exam
The matching test is an objective test that is closely related to the multiple-choice test. A series of items is listed down the left-hand column of the test paper and a series of options is listed down the right-hand column. The student then picks the option that goes with each item. As is true with all tests, the construction of good matching tests is the product of ample time and care and the application of a set of rules that define good times. From Cunningham (1986) here are some suggestions for good item writing:
• Use only homogenous subject matter
• Do not have the same number of items and options
• Arrange the list of responses in a logical order
• Keep the list of items brief
• Always place the entire task on the same page

The True-False Exam
True-false tests owe much of their popularity to objectivity in scoring and ease of construction. Their inclusion also permits the insertion of a larger number of items than do other item formats. Even though it is easy to generate a large number of items, the true-false test is not considered to be a sound method of assessing student performance. This is because it is hard to write items that are not too easy, too difficult, or so ambiguous and tricky that they provide a poor assessment of knowledge. Nevertheless, if you choose to use true-false items here are some suggestions for good item writing (Cunningham, 1986):
Avoid statements that are too general
Do not use negatives or double negatives
Do not use long, complex statements
Do not include more than one idea
If you are using an opinion, indicate the source

The Essay Exam
Since objective tests (i.e., multiple choice) were first introduced there has been considerable debate in the field of educational measurement concerning the relative merits of essay exams. Among psychometrists, the issue has been resolved in the favor of objective tests. The primary weakness with essay tests is that there is no way to accurately or reliably grade the test. The best tests should be measuring a single trait, while essay tests scores are often confounded by unrelated variables. The advantages of essay exams is that they minimize guessing, force the student to construct his/her own exam, and assess the student's ability to bring disparate material into a meaningful whole.

From Cunningham (1986) here are some suggestions for good item writing:

• Do not employ optional questions
• Specify the value and approximate time for each question
• Score all answers to one question before scoring the next
• Evaluate essay responses anonymously

References


IN CONCLUSION

The Testing Center hopes that you have found this manual helpful and informative. We welcome any feedback which would make it better and easier to use.

The Testing Center exists to lighten your teaching load. Please feel free to utilize us to the fullest extent possible. We look forward to working with you.